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Исполняемые модули - это различные программы Oracle Reports:

обзор исполняемых модулей   - 1 - 2

помощь по опциям командной строки   - 1 - 3

правила синтаксиса командной строки   - 1 - 4

аргументы из ключевых слов   - 1 - 6

вхождение в базу данных   - 1 - 7

синтаксис R25CONV   - 1 - 9

синтаксис R25RUN   - 1 - 17

синтаксис R25DES   - 1 - 35

Стр. 1-2



Обзор исполняемых модулей



Имена и назначение четырех исполняемых модулей Oracle Reports приведены ниже:

R25CONV�Преобразует определения вашего отчета из одного формата хранения (напр., база данных, файл .rdf, файл .rep, файл .rex) в другой, или из одной единицы измерения (напр., символ, сантиметр, дюйм, точка) в другую. Дополнительную информацию о форматах файлов см. в “Хранении файлов Oracle Reports” на стр. 18-2. Если преобразование выполняется в интерактивном режиме, то появится диалоговое окно Convert. Если преобразование выполняется в пакетном режиме, то диалоговое окно Convert не появляется.��R25MREP�Преобразует ваши отчеты и файлы определения принтеров SQL*ReportWriter версии 1.1 в Oracle Reports. Дополнительную информацию об этом исполняемом модуле см. в Reports Migration Manual.��R25RUN�Выполняет ваш отчет в пакетном или интерактивном режиме. Если отчет выполняется в интерактивном режиме, то появляется корневое окно, из которого вы можете выполнять отчеты. Если отчет выполняется в пакетном режиме, то это окно не появляется.

Если во время выполнения вы хотите ввести значения для параметров, но хотите выполнить отчет в пакетном режиме, то или введите параметры в командной строке, или создайте командный файл.��R25DES�Вызывает дизайнер (то есть корневое окно и средства рисования, в которых вы строите и поддерживаете отчеты).��Стр. 1-3



Имена исполняемых модулей



Если режим GUI исполняемого модуля отличается от встроенного GUI, то к именам вышеуказанных исполняемых модулей добавляются буквы. Например, “а” означает режим GUI Apple MacIntosh, а “m” - режим GUI Motif. (Отсутствие добавочной буквы означает, что режим GUI исполняемого модуля - встроенный GUI.) Кроме того, для указания того, что с исполняемым модулем связаны выходы пользователя, используется “х”.

Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.



Вызов исполняемых модулей



Исполняемые модули Oracle Reports можно вызывать двумя способами:

в командной строке

иконкой

Аргументы исполняемого модуля   Вызывая исполняемый модуль Oracle Reports, вы можете вводить аргументы исполняемого модуля, которые управляют поведением этого исполняемого модуля. Если вы вызываете исполняемый модуль из командной строки, то после имени исполняемого модуля вы вводите в командной строке аргументы исполняемого модуля.

Если операционная система не имеет доступной командной строки (т.е. Apple Macintosh или Windows) и вы вызываете исполняемый модуль с помощью иконки, то может появиться промежуточное диалоговое окно, в котором вы можете вводить значения для аргументов исполняемого модуля, или вам может понадобиться воспользоваться для аргументов исполняемого модуля закладками Runtime Settings или Runtime Parameters в диалоговом окне Tools Options (Tools->Tools Options). Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.

Синтаксис и аргументы исполняемых модулей R25CONV, R25RUN и R25DES описаны в следующих разделах.



Помощь по опциям командной строки



Если вы находитесь в командной строке, то вы можете увидеть опции командной строки исполняемого модуля, введя имя исполняемого модуля, затем пробел и знак вопроса, нажав затем Return. Например, r25conv “?”.
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Примечание: Некоторые операционные системы требуют брать знак вопроса в кавычки. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы. Например, чтобы просмотреть опции командной строки для исполняемого модуля R25DES в C shell UNIX, вам нужно ввести r25des “?”.



Правила синтаксиса исполняемых модулей



Если вы вводите исполняемый модуль в командной строке, то обычно он имеет форму, показанную ниже:

executable_name keyword1=value1 keyword2=value2 ...

Если операционная система не имеет доступной командной строки (т.е. Apple Macintosh или Windows) и вы вызываете исполняемый модуль с помощью иконки, то может появиться промежуточное диалоговое окно, в котором вы можете вводить значения для аргументов исполняемого модуля, или вам может понадобиться воспользоваться для аргументов исполняемого модуля закладками Runtime Settings или Runtime Parameters в диалоговом окне Tools Options (Tools->Tools Options). Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.

Каждое keyword=value называется аргументом исполняемого модуля. Так как всякий раз вводить ключевые слова обременительно, они могут быть опущены. Дополнительную информацию о ключевых словах см. в “Использовании ключевых слов” на стр. 1-6.

Ко всем исполняемым модулям Oracle Reports применяются следующие правила синтаксиса:

Правила:

До или после знака равенства аргумента не должно быть пробелов.

Разделяйте аргументы одним или более пробелами; не используйте для разделения аргументов запятых.

Значения аргументов могут быть в одиночных или двойных кавычках. Действие одиночных или двойных кавычек специфично для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.
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Часть keyword= всех аргументов нечувствительна к регистру. Часть значения аргументов SOURCE, DEST, CMDFILE, TERM, DESNAME, DESFORMAT, DNAME и SNAME может быть чувствительна к регистру, это зависит от операционной системы. Часть значения всех остальных аргументов к регистру нечувствительна. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.

Ключевые слова иногда могут быть опущены. Дополнительную информацию о ключевых словах см. в “Использовании ключевых слов” на стр. 1-6.

Чтобы аргументу в качестве значения дать пустую цепочку, вы вводите keyword= или keyword=“”. Если пустую цепочку вы вводите таким способом, то Форма Параметров во время выполнения вместо начального значения для этого аргумента покажет пустую цепочку.

Для обращения ко всем файлам поддерживаются полные имена путей (напр., desname=/revenues/q1/nwsales). Если вы не укажете полного пути, то Oracle Reports для обнаружения этого файла будет использовать свой порядок поиска путей к файлам. Дополнительную информацию о порядке поиска путей к файлам см. в “Способе поиска файлов” на стр. 18-9.

Примечание: Для обеспечения переносимости ваших отчетов вы можете использовать специфическую для Oracle Reports переменную среды REPORTS25_PATH для обращения к отчетам, внешним запросам, внешним библиотекам PL/SQL, текстовым файлам, графике и т.д. REPORTS25_PATH предоставляет вам возможность доступа к файлам, хранимым вне Oracle Reports, не указывая жестко путей директориев в вашем отчете.

Дополнительную информацию об этих переменных см. в “Способе поиска файлов” на стр. 18-9. Дополнительную информацию об установке этих переменных среды см. в Developer/2000 Installation Guide для вашей операционной системы.

Значения, вводимые из Формы Параметров во время выполнения, подавляют значения, введенные в командной строке. Например, если вы в командной строке определили R25RUN с COPIES равным 1, но в Форме Параметров во время выполнения указали COPIES равным 2, то будет сгенерировано две копии отчета.

Подобным же образом, значения, введенные в командной строке, подавляют значения, указанные в командных файлах. Например, предположим, что вы определили R25RUN из командной строки с COPIES равным 1, и CMDFILE равным RUNONE (командный файл). В RUNONE командой R25RUN COPIES установлено на 2. В таком случае будет сгенерирована только одна копия отчета.
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В Oracle Reports значения для DESTYPE, DESNAME, DESFORMAT, ORIENTATION и COPIES вы можете указывать в ряде других мест. Порядок приоритета для тех мест, в которых вы указываете эти значения, показывает следующий список. Первый элемент в списке имеет приоритет над всеми остальными, второй имеет приоритет над всеми остальными, кроме первого, и так далее:

диалоговое окно Print Job

Форма Параметров во время выполнения

закладка Runtime Parameters/Settings диалогового окна Tools Options

ключевые слова в командной строке

значения, указываемые в определении отчета

диалоговое окно Choose Printer



Использование ключевых слов



Часть keyword= каждого аргумента необязательна, если аргументы вводятся в том порядке, в котором они указаны синтаксисом. Если вы пропустите один из аргументов, то после пропущенного аргумента вы должны использовать ключевые слова.

Если исполняемый модуль имеет четыре аргумента, а вы хотите указать только первый, второй и четвертый, то первые два вы можете указать без ключевых слов. Четвертый потребует ключевого слова, потому что вы вводите его не в том порядке, который указан синтаксисом.

Примеры (допустимые):

Ниже даются примеры допустимых последовательностей командной строки:

r25des userid=scott/tiger paramform=no destype=mail desname=rmiller

r25des scott/tiger no destype=mail desname=rmiller

Заметьте, что в этом примере после использования ключевого слова DESTYPE все последующие аргументы также используют ключевые слова. Если однажды введено ключевое слово, то все остальные аргументы в командной строке также должны использовать ключевые слова.

Примеры (недопустимые):

Ниже даются примеры недопустимых последовательностей командной строки:

r25des paramform=no scott/tiger destype=mail desname=rmiller
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Вышеприведенная последовательность недопустима из-за того, что scott/tiger было набрано не в том порядке и без ключевого слова USERID.

r25des scott/tiger mail rmiller no

Вышеприведенная последовательность недопустима из-за того, что значение NO введено не в том порядке и без ключевого слова PARAMFORM.



Вхождение в базу данных



При вызове исполняемых модулей R25CONV, R25RUN или R25DES, или при использовании дизайнера R25DES вы можете подсоединиться к базе данных следующими способами:

явное вхождение   - 1 - 7

автоматическое вхождение   - 1 - 7

удаленное вхождение   - 1 - 8



Явное вхождение



Вы явно входите в базу данных, используя для R25CONV, R25RUN или R25DES ключевое слово USERID, или выбирая File->Connect в дизайнере R25DES или в программных средствах доступа R25RUN во время выполнения. Ключевое слово USERID описано ниже.



USERID

Это имя пользователя и пароль ORACLE с необязательным адресом SQL*Net (бюджет не SYSTEM). Если вы опустите пароль, то предоставляется экран вхождения. Дополнительную информацию о необязательном адресе SQL*Net см. в “Удаленном вхождении” на стр. 1-8. Дополнительную информацию об автоматическом вхождении см. в “Автоматическом вхождении” на стр. 1-7.

Опции: 	Определение вхождения может иметь одну из следующих форм и длиной не может превышать 512 байтов:

username		username/password

username@node	username/password@node



Автоматическое вхождение



Свойство автоматического вхождения в ORACLE позволяет вам подсоединяться к Oracle Reports без явного задания имени пользователя и пароля. Вы можете использовать свойство автоматического вхождения со всеми исполняемыми модулями Oracle Reports, имеющими ключевое слово USERID. Дополнительную информацию об использовании этого свойства см. в ORACLE7 Server Administrator’s Guide.
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Когда вы подсоединяетесь таким способом, то ORACLE использует вхождение по умолчанию (напр., OPS$), чтобы ассоциировать ваше имя пользователя ORACLE с именем пользователя операционной системы. Для вызова процедуры автоматического вхождения сделайте одно из следующих действий:

Наберите в командной строке r25conv /

На экране вхождения в качестве имени пользователя введите слэш (/)

Опустите в командной строке свое имя пользователя/пароль и дважды нажмите клавишу Return когда появится форма вхождения

Примечание: При вхождении таким способом вы можете получить доступ к удаленному вхождению, набрав после слэша @node.

Дополнительную информацию о вхождениях по умолчанию см. в ORACLE7 Server SQL Language Reference Manual.



Удаленное вхождение



Через SQL*Net вы можете указать удаленную базу данных (т.е. не в вашем компьютере). Когда вы используете свойство удаленного вхождения, то удаленная база данных для вас прозрачна - Oracle Reports ведет себя одинаково как при доступе к узлу через всю страну, так и при доступе к базе данных в вашем компьютере.

Синтаксис

@driver_name:node_name[:db_name]

Аргументы

driver_name�Драйвер, который вы хотите использовать для доступа к удаленной базе данных (напр., @t:, @d:). Установка по умолчанию зависит от системы.��node_name�Удаленный сетевой узел, содержащий целевую базу данных (напр., london).��db_name�Имя базы данных (напр., :rds). Если вы не укажете базу данных, то войдете в базу данных на узле, указанном по умолчанию.��Дополнительную информацию об SQL*Net см. в SQL*Net User’s Guide.

Примеры:

Чтобы запустить на выполнение отчет order_entry на базе данных по умолчанию в узле london, вы могли бы набрать следующее:

r25run order_entry scott/tiger@D:london

Чтобы запустить на выполнение отчет ORDER_ENTRY на определенной базе данных узла LONDON, вы могли бы набрать следующее:

r25run order_entry scott/tiger@D:london:rds
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Правила:

Чтобы осуществить удаленное подсоединение, вы должны иметь бюджет на том удаленном компьютерном узле, на котором располагается целевая база данных.



R25CONV



R25CONV дает вам возможность преобразования одного или более определений отчетов или библиотек PL/SQL из одного формата хранения в другой.

Синтаксис:

r25conv [ [keyword=]value ] ...

где допустимыми аргументами keyword=value являются следующие:

[[USERID=]userid ]

[[STYPE=]{database|plldb|pldfile|pllfile|rdffile|rexfile} ]

[[SOURCE=]{sname|)sname1,sname2,...)} ]

[[DTYPE=]{database|plldb|pldfile|pllfile|rdffile|repfile|rexfile} ]

[[DEST=]{dname|(dname1,dname2,...)|pathname} ]

[[CMDFILE=]cmdfile ]

[[LOGFILE=]logfile ]

[[OVERWRITE=]{yes|no|PROMPT} ]

[[BATCH=]{yes|no} ]

[[DUNIT=]{centimeter|character|inch|point} ]

[[PAGESIZE=]width x height

[[FORMSIZE=]width x height

Описание:

Используйте исполняемый модуль R25CONV для преобразования одного или более определений отчетов или библиотек PL/SQL из одного формата хранения в другой. (Этот исполняемый модуль заменяет исполняемые модули DUMPREP, GENREP и LOADREP версии 1.1.)

С использованием R25CONV могут выполняться следующие преобразования отчетов:

преобразование отчета, хранимого в базе данных, в файл .rep, .rex или .rdf

преобразование отчета, хранимого в файле .rdf, в файл .rep или .rex, или в отчет базы данных

преобразование отчета, хранимого в файле .rex, в отчет базы данных, в файл .rdf или .rep
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С использованием R25CONV могут выполняться следующие преобразования библиотек PL/SQL:

преобразование библиотеки, хранимой в базе данных, в файл .pld или .pll

преобразование библиотеки, хранимой в файле .pld, в библиотеку базы данных или в файл .pll

преобразование библиотеки, хранимой в файле .pll, в библиотеку базы данных или в файл .pld

Дополнительную информацию о форматах хранения см. в “Хранении файлов Oracle Reports” на стр. 18-2.

Примечание: Преобразовывать отчеты вы можете также, находясь в дизайнере и выбирая File->Administration->Convert....

Правила:

В некоторых случаях Convert автоматически скомпилирует PL/SQL отчета как часть процесса преобразования. При условии, что цель Destination вашего преобразования - не файл .rex, PL/SQL автоматически компилируется при следующих обстоятельствах:

Используя Convert, вы пытаетесь создать файл .rep. Если имеются ошибки компиляции, то выводится сообщение об ошибке и файл .rep не создается.

В качестве источника Source отчета вы используете файл .rex. Если имеются ошибки компиляции, то выводится сообщение, но преобразование продолжается.

В качестве источника Source отчета вы используете отчет, созданный на другой платформе. Если имеются ошибки компиляции, то выводится сообщение, но преобразование продолжается.

Во всех других ситуациях вы должны PL/SQL отчета компилировать сами (напр., File-> Compile).

Примечание: Во избежание проблем с компиляцией во время преобразования перед попыткой преобразования скомпилируйте PL/SQL Source отчета, используя File-> Compile.

Шрифты преобразуются при открытии отчета дизайнером или во время выполнения Oracle Reports. Во время преобразования шрифты не преобразуются.

USERID

Ваше вхождение в базу данных. Дополнительную информацию см. во “Вхождении в базу данных” на стр. 1-7.
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Правила:

Ключевое слово USERID необходимо только в случае, если STYPE или DTYPE равно database.

STYPE

Формат преобразуемого отчета(ов) или библиотек.

Опции:	database означает, что исходный(е) отчет(ы) хранятся в ORACLE.

plldb означает, что исходные библиотеки PL/SQL хранятся в базе данных.

pldfile означает, что исходные библиотеки PL/SQL хранятся в файлах в формате ASCII.

pllfile означает, что исходные библиотеки PL/SQL хранятся в файлах, содержащих исходный код и Р-код.

rdffile означает, что исходный(е) отчет(ы) хранятся в одном или более файлах определений отчетов (файлах с расширением .rdf).

rexfile означает, что исходный(е) отчет(ы) хранятся в одном или более текстовых файлах (файлах с расширением .rex).

По умолчанию: database

SOURCE

Это преобразуемые отчет/библиотека или список отчетов/библиотек. R25CONV требует, чтобы вы указывали исходный отчет или библиотеку.

Опции:	Любое допустимое имя отчета/библиотеки или имя файла (напр., qanda).

Список допустимых имен отчетов/библиотек или имен файлов, заключенный в скобки, с запятой в качестве разделителей имен (напр., (qanda, test,dmast)).

Примечание: Для отчетов или библиотек, хранимых в базе данных, могут использоваться метасимволы SQL (% и _). Например, R% извлечет все отчеты, хранимые в базе данных, которые начинаются с R. Все отчеты, соответствующие этому условию, будут преобразованы.

Правила:

Список имен отчетов/библиотек или имен файлов должен заключаться в скобки с запятой в качестве разделителя имен. Например:

(qanda,test,dmast)

(qanda, test, dmast)
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Метасимволы недопустимы для отчетов/библиотек, хранимых в файлах (т.е. с расширениями .rdf, .rep, .rex, .pld, .pll).

Аргумент(ы) для этого ключевого слова могут быть специфичны для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.

Если вы преобразуете отчеты/библиотеки, хранимые в ORACLE, и используете таблицы Oracle Reports, находящиеся в собственности системы, то вы можете перечислять отчеты/библиотеки других пользователей, например:

SOURCE=(sday, qanda, dsmith.test, dmast.sal)

Если вы используете таблицы Oracle Reports, находящиеся в собственности пользователя, то отчеты/библиотеки пользователей должны преобразовываться каждым пользователем индивидуально.

Чтобы преобразовывать отчеты/библиотеки, они у вас должны быть созданы, или вам должны быть предоставлены права доступа к тем, которые создавали не вы. Если перед именем отчета/библиотеки идентификатора пользователя нет, то идентификатором пользователя предполагается текущий пользователь.

Если вы преобразуете из базы данных в файл и имя отчета/библиотеки слишком длинное, чтобы быть именем файла, то Oracle Reports просит вас дать имя файла такой длины, которая была бы правильной для вашей операционной системы.

DTYPE

Формат, в который преобразуются отчеты и библиотеки.

Опции:	database означает, что преобразованные отчеты будут храниться в ORACLE.

plldb означает, что преобразованные библиотеки PL/SQL будут храниться в базе данных.

pldfile означает, что преобразованные библиотеки PL/SQL будут храниться в файлах в формате ASCII.

pllfile означает, что преобразованные библиотеки PL/SQL будут храниться в файлах, содержащих исходный код и Р-код.

rdffile означает, что преобразованные отчеты будут храниться в одном или более файлах определений отчетов (файлах с расширением .rdf).

reрfile означает, что преобразованные отчеты будут храниться в одном или более двоичных исполняемых файлах (файлах с расширением .reр).
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reхfile означает, что преобразованные отчеты будут храниться в одном или более текстовых файлах (файлах с расширением .reх).

По умолчанию: reхfile

Правила:

Когда вы, используя R25CONV, пытаетесь создать файл .rep, автоматически компилируется PL/SQL исходного отчета. Если имеются ошибки компиляции, то выводится сообщение об ошибке и файл .rep не создается.

Во избежание этой проблемы, прежде чем создавать файл .rep, обязательно скомпилируйте PL/SQL исходного отчета с помощью File->Compile.

DEST

Имя (имена) преобразованных отчетов или библиотек, если они хранятся в базе данных, или имена самих файлов.

Опции: 	Любое допустимое имя отчета/библиотеки (напр., qanda).

Список допустимых имен отчетов/библиотек или имен файлов, заключенный в скобки, с запятой в качестве разделителя имен (напр., (qanda,test, dmast)).

По умолчанию: Если ключевое слово DEST не указано, то R25CONV использует следующие имена по умолчанию:

Если DTYPE database или plldb, то DEST - SOURCE.

Если DTYPE pldfile, то DEST - SOURCE с расширением файла .pld.

Если DTYPE pllfile, то DEST - SOURCE с расширением файла .pll.

Если DTYPE rdffile, то DEST - SOURCE с расширением файла .rdf.

Если DTYPE repfile, то DEST - SOURCE с расширением файла .rep.

Если DTYPE rexfile, то DEST - expdat.rex.

Правила:

Список имен отчетов/библиотек или имен файлов должен заключаться в скобки с запятой в качестве разделителя имен. Например:

(qanda,test,dmast)

(qanda, test, dmast)
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Если у вас целевых имен больше, чем имен источников, то лишние целевые имена игнорируются. Если у вас целевых имен меньше, чем имен источников, то после исчерпания целевых имен будут использоваться имена по умолчанию.

Аргументы для этого ключевого слова могут быть специфичны для операционной системы. Дополнительную информацию см. в 
Developer/2000 Installation Guide
 для вашей операционной системы.

CMDFILE

Файл, содержащий аргументы для команды R25CONV. Эта опция дает вам возможность преобразовывать отчет/библиотеку без необходимости указывать большое количество аргументов при каждом вызове R25CONV.

Опции:	Любой допустимый командный файл.

Правила:

Командный файл может обращаться к другому командному файлу.

Синтаксис командного файла для аргументов R25CONV идентичен тому, который используется в командной строке.

Значения, вводимые в командной строке, подавляют значения, указанные в командном файле. Например, предположим, что вы в командной строке указали R25RUN с COPIES равным 1 и CMDFILE равным RUNONE (командный файл). В RUNONE COPIES установлен
 на 2. В таком случае будет сгенерирована только одна копия отчета. Дополнительную информацию см. в “Правилах синтаксиса командной строки” на стр. 1-4.

Аргументы для этого ключевого слова могут быть специфичны для операционной системы. Дополнительную информацию см. в 
Developer/2000 Installation Guide
 для вашей операционной системы.

LOGFILE

Имя файла, в который будет отсылаться вывод статуса и ошибок.

Опции: 	Любое допустимое имя файла.

По умолчанию: dfltrep.log в текущем директории.

OVERWRITE

Перезаписывать ли существующие файлы или объекты базы данных преобразованными файлами или объектами.

Опции: 	YES означает автоматическую перезапись любых существующих файлов или объектов базы данных с таким же именем.

NO означает не преобразовывать отчет, если имеются существующие файлы или объекты базы данных с таким же именем, и выводить предупреждающе сообщение.
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PROMPT означает запрашивать вас, прежде чем перезаписать какие-либо существующие файлы или объекты базы данных.

По умолчанию: NO

BATCH

Подавляет весь ввод и вывод терминала, чтобы преобразовывать отчеты/библиотеки без вмешательства пользователя.

Опции: 	YES подавляет весь ввод и вывод терминала.

NO разрешает специальный ввод и вывод терминала. Выводится диалоговое окно Convert, 
и 
когда вы подтвердите это диалоговое окно, выполняется преобразование.

По умолчанию: NO

DUNIT

Целевая единица измерения, в которую должен быть преобразован отчет. Если указана, то DUNIT должна отличаться от единицы измерения исходного отчета. Если оставлена пустой, то в качестве единицы измерения целевого отчета используется единица измерения исходного отчета.

Опции: 	centimeter означает, что преобразованные отчеты будут начально использовать в качестве единицы измерения сантиметры.

character означает, что преобразованные отчеты будут начально использовать в качестве единицы измерения символы.

inch означает, что преобразованные отчеты будут начально использовать в качестве единицы измерения дюймы.

point означает, что преобразованные отчеты будут начально использовать в качестве единицы измерения точки.

По умолчанию: Пусто.

PAGESIZE

Размер логической страницы для преобразованных отчетов, выраженный в целевых единицах измерения (указанных с помощью ключевого слова DUNIT).

Опции: 	Любое допустимое значение в единицах измерения и в форме 
ширина
 х 
высота
.

По умолчанию: Для двоичного отображения 8.5 х 11 дюймов. Для символьного режима 80 х 66 символов. Если отчет спроектирован для символьного режима, а выполняется или преобразуется в двоичном отображении, то для определения размера страницы, если он не указан, используется следующая формула: (размер страницы по умолчанию * размер символьной страницы)/размер символьной страницы по умолчанию. Например, если размер символьной страницы 80 х 20, то размер страницы с двоичным отображением будет: (8.5*80)/80х(11*20)/66 = 8.5 х 3.33.
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Правила:

Для несимвольных единиц измерения вы можете использовать для указания десятичной части десятичное выражение (напр., 8.5 х 11).

FORMSIZE

Размер Формы Параметров во время выполнения для преобразованного отчета, выраженный в целевых единицах измерения (указанных с помощью ключевого слова DUNIT).

Опции: 	Любое допустимое значение в единицах измерения и в форме 
ширина
 х 
высота
.

Правила:

Для несимвольных единиц измерения вы можете использовать для указания десятичной части десятичное выражение (напр., 8.5 х 11).
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R25RUN



R25RUN 
интерактивно или в пакете
 
запускает 
на выполнение 
отчет 
(
т.е. файл .rdf или .rep)
.

Синтаксис

r25run [ [keyword=]value|(value1, value2, ...) ]

где допустимыми аргументами keyword=value являются следующие:

[ [MODULE|REPORT=]runfile ]

[ [USERID=]userid ]

[ [PARAMFORM=]{yes|no} ]

[ [CMDFILE=]cmdfile ]

[ [TERM=]termfile ]

[ [ARRAYSIZE=]n ]

[ [DESTYPE=]{screen|file|printer|preview|sysout|mail|}]

[ [DESNAME=]desname ]

[ [DESFORMAT=]desformat ]

[ [COPIES=]n ]

[ [CURRENCY=]currency_symbol ]

[ [THOUSANDS=]thousands_symbol ]

[ [DECIMAL=]decimal_symbol ]

[ [READONLY=]{yes|no} ]

[ [LOGFILE=]logfile ]

[ [BUFFERS=]n ]

[ [BATCH=]{yes|no} ]

[ [PAGESIZE=]width x height ]

[ [PROFILE=]profiler_file ]

[ [RUNDEBUG=]{yes|no} ]

[ [ONSUCCESS=]COMMIT|ROLLBACK|NOACTION]

[ [ONFAILURE=]COMMIT|ROLLBACK|NOACTION]

[ [KEYIN=]keyin_file ]

[ [KEYOUT=]keyout_file ]

[ [ERRFILE=]error_file ]

[ [LONGCHUNK=]n ]

[ [ORIENTATION=]DEFAULT|LANDSCAPE|PORTRAIT ]

[ [BACKGROUND=]{yes|no} ]

[ [MODE=]BITMAP|CHARACTER|DEFAULT ]

[ [PRINTJOB] {yes|no} ]

[ <param>=value ]

[ [TRACEFILE=]tracefile ]

[ [TRACEMODE=]{TRACE_APPEND|TRACE_REPLACE} ]

[ [TRACEOPTS=]{TRACE_ERR|TRACE_PRF|TRACE_APP|TRACE_PLS|TRACE_SQL|TRACE_TMS| TRACE_ALL|(opt1, opt2, ...)} ]

[ [AUTOCOMMIT=]{yes|no} ]

[ [NONBLOCKSQL=]{yes|no} ]
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Описание:

Используйте исполняемый модуль R25RUN для выполнения отчета из операционной системы. С помощью R25RUN вы можете также выполнить отчет в пакетном режиме, т.е. без вмешательства пользователя. Прежде чем выполнять отчет, вы должны создать исполняемый файл (т.е. файл
, имеющий расширение .rdf или .rep). Дополнительную информацию о создании исполняемого файла см. в “R25RUN” на стр. 1-9. Дополнительную информацию см. в “Преобразовании” на стр. iv.

Предупреждение: R25RUN 
перед выполнением
 
не компилирует PL/SQL в вашем отчете
. В файле .rep PL/SQL уже скомпилирован, но в файле .rdf он скомпилирован только в случае, если вы его специально скомпилировали. Если при выполнении отчета имеется нескомпилированный PL/SQL, то вы получите ошибку и отчет не выполнится. Для предварительной компиляции PL/SQL в файле .rdf воспользуйтесь File->Compile...

Есть две версии R25RUN:

Исполняемый модуль с символьным режимом для тех пользователей, которые выполняют отчеты на устройствах с символьным режимом (напр., VT220).

Исполняемый модуль GUI для тех пользователей, которые выполняют отчеты на устройствах с двоичным отображением (напр., ПК под Windows).

Важно заметить, что с любым из этих исполняемых модулей вы можете выполнять отчеты с символьным режимом или с двоичным отображением. Единственный ограничивающий фактор - устройство вывода (напр., вы не можете выполнить отчет с двоичным отображением на экране vt220).

MODULE/REPORT

Отчет, предназначенный для выполнения. (REPORT разрешается для обратной совместимости.)

Опции:	Любой допустимый выполняемый файл (т.е. файл с расширением .rdf или .rep). Если вы не введете расширение файла, то Oracle Reports сначала будет искать файл с расширением .rep, затем с расширением .rdf, а затем без расширения. Для поиска файла Oracle Reports будет пользоваться своим порядком поиска путей к файлам. Дополнительную информацию о порядке поиска путей к файлам см. в “Способе поиска файлов” на стр. 18-9.

Правила:

Если вы указываете выполняемый файл с использованием MODULE/REPORT, то корневое окно R25RUN не выводится, File->Run, File->Print и Edit->Runtime Settings отключены. (Такое поведение позволяет производить непрерывный вход в R25RUN из других прикладных программ.) Если вы не указываете выполняемый файл с помощью MODULE/
REPORT и указываете BATCH=NO, то открывается окно, позволяющее вам 
интерактивно
 
запускать отчеты на выполнение
.
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Если вы выполняете отчет с символьным режимом через R25RUN с двоичным отображением, то Oracle Reports выводит предупреждение, затем выполняет отчет, используя размер страницы 8.5” х 11” и размер формы 7” х 6”.

USERID

Ваше вхождение в базу данных. Дополнительную информацию см. во “Вхождении в базу даанных” на стр. 1-7.

PARAMFORM

При исполнении отчета выводит Форму Параметров во время выполнения. Дополнительную информацию о Форме Параметров во время выполнения см. в “Форме Параметров во время выполнения” на стр. 9-2.

Опции: 	YES означает вывод Формы.

NO означает подавление Формы.

По умолчанию: YES

Правила:

PARAMFORM=YES несовместомо с BATCH=YES, так как появление Формы Параметров во время выполнения в пакетном режима бессмысленно.

CMDFILE

Файл, содержащий аргументы для команды R25RUN. Эта опция дает вам возможность запускать отчет на выполнение без необходимости указывать большое количество аргументов при каждом вызове R25RUN.

Опции: 	Любой допустимый командный файл.

Правила:

Командный файл может обращаться к другому командному файлу.

Синтаксис командного файла для аргументов R25RUN идентичен используемому в командной строке.

Значения, вводимые в командной строке, подавляют значения, указанные в командном файле. Например, предположим, что вы в командной строке указали R25RUN с COPIES равным 1 и CMDFILE равным RUNONE (командный файл). В RUNONE COPIES установлено на 2. В таком случае будет сгенерирована только одна копия отчета. Дополнительную информацию см. в “Правилах синтаксиса командной строки” на стр. 1-4.

Аргументы для этого ключевого слова могут быть специфичны для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.
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TERM

Файл определения терминалов, описывающий терминал, с которого вы используете R25RUN. Далее, этот файл определяет 
соответств
ие
 
клавиш
 
функциям Oracle Reports. TERM используется только для Формы Параметров во время выполнения и для Предпросмотровщика. Это ключевое слово используется только в символьном режиме.

Опции: 	Любой допустимый файл определения терминалов.

По умолчанию: Зависит от инсталляции. (Совместимое определение спросите у своего системного администратора.)

Правила:

Аргумент(ы) для этого ключевого слова могут быть чувствительны к регистру, что зависит от вашей операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе.

ARRAYSIZE

Размер массива в килобайтах для использования в обработке массива ORACLE. В общем случае, чем больше размер массива, тем быстрее будет выполняться отчет.

Опции: 	Число от 1 до 9,999. Это означает, что такое количество килобайтов памяти Oracle Reports может использовать на каждый запрос в вашем отчете.

По умолчанию: Размер массива по умолчанию 10К. Подробности насчет обработки массива ORACLE см. в ORACLE7 Server Administrator’s Guide.

DESTYPE

Тип целевого устройства, которое будет принимать вывод отчета.

Опции: 	Screen направляет вывод в Предпросмотровщик для интерактивного просмотра. Это значение допустимо только в случае, когда BATCH=NO.

File сохраняет вывод в файл, названный в DESNAME (следующее рассматриваемое ключевое слово).

Printer направляет вывод на принтер, названный в DESNAME (следующее рассматриваемое ключевое слово).

Preview также направляет вывод в Предпросмотровщик для интерактивного просмотра. Но Предпросмотровщик заставляет форматировать вывод как вывод PostScript. Чтобы определить какие шрифты принтера использовать для вывода на экран, Предпросмотровщик будет использовать DESNAME.
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Mail отсылает вывод пользователям Oracle*Mail, указанным в DESNAME. Если в вашей системе Oracle*Mail не инсталлирован
 или система не является узлом Oracle*Mail, то будет возвращена ошибка. Отчет может отсылаться как часть сообщения или как подсоединенный файл.

Дополнительную информацию см. в “Интеграции с другими продуктами” на стр. 16-1.

Sysout отсылает вывод на устройство вывода операционной системы по умолчанию. Это значение допустимо только в случае, если BATCH=YES.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESTYPE. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Если вы установите DESTYPE на Printer, File, или Mail, то после вашего согласия с Формой Параметров во время выполнения, если только она не подавлена, появится диалоговое окно Print Job. После вашего согласия с диалоговым окном Print Job отчет исполняется и вывод отсылается на принтер (указанный в File->Choose Printer), в файл или почтовому идентификатору.

Если DESTYPE отлич
е
н
 от Printer, File, или Mail, то отчет исполняется после вашего согласия с Формой Параметров во время выполнения. Внешний вид этого диалогового окна меняется в зависимости от операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе.

В некоторых случаях этот параметр может быть перезаписан вашей операционной системой. Дополнительную информацию см. в 
Developer/2000 Installation Guidе
.

Все значения DESTYPE 
в каждой операционной системе
 
не поддерживаются
. Дополнительную информацию см. в Developer/2000 Installation Guidе.

DESNAME

Имя файла, принтера или имя пользователя Oracle*Mail (или список рассылки), которому будет отсылаться вывод отчета. Чтобы отослать вывод отчета пользователю Oracle*Mail, укажите имя этого пользователя, как вы это делаете в Oracle*Mail. Вы можете указать несколько имен пользователей, заключив их в скобки и отделяя друг от друга запятыми (напр., (<name>,<name>,...<name>)).
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Опции:	Любое допустимое имя файла, имя принтера или идентификатор пользователя Oracle*Mail, не превышающее длиной 1К. Для имен принтеров вы необязательно можете указывать порт. Например:

DESNAME=
<
printer_name>,LPT1;

DESNAME=
<
printer_name>,FILE;

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESNAME. Если DESTYPE=FILE и DESNAME - пустая цепочка, то во время выполнения оно устанавливется на <reportname>.lis. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен на Screen или Sysout.

Если DESTYPE установлен на Preview, то Oracle Reports для определения того, какие шрифты принтера использовать для вывода на экран, использует DESNAME.

Аргумент(ы) для этого ключевого слова могут быть чувствительны к регистру, что зависит от вашей операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе.

В некоторых случаях этот параметр может быть перезаписан вашей операционной системой. Дополнительную информацию см. в Developer/2000 Installation Guidе.

DESFORMAT


Е
сли DESTYPE установлен на File, 
то в
 средах с двоичным отображением, 
указывает на драйвер принтера. В средах с символьным режимом указывает на характеристики принтера, названного в DESNAME.

Опции:	Любой допустимый целевой формат, не превышающий длиной 1К. Примерами допустимых значений для этого ключевого слова могут быть hpl, hplwide, dec, decwide, decland, dec180, dflt, wide и т.д. Список допустимых целевых форматов попросите у вашего системного администратора.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESFORMAT. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45. 
Е
сли
 DESFORMAT пустой или установлен на dflt, 
то д
ля Oracle R
eports с двоичным отображением 
используется текущий драйвер принтера, выбранный в Choose Printer. Если в Choose Printer ничего не выбрано, то по умолчанию используется PostScript.

Стр. 1-23

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен на Screen или Sysout.

Аргумент(ы) для этого ключевого слова могут быть чувствительны к регистру, что зависит от вашей операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе.

COPIES

Количество копий отчета для печати.

Опции: 	Любое допустимое целое число от 1 до 9,999.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра COPIES. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен не на Printer.

Если COPIES в Форме Параметров во время выполнения оставлен пустым, то по умолчанию равен одному.

CURRENCY

Денежный знак для использования в числовых форматах.

Опции: 	Любая допустимая алфавитно-цифровая цепочка, не превышающая длиной 1К.

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра CURRENCY значение по умолчанию длиной до четырех символов в поле Initial Value окна свойств Parameter.

Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Значение CURRENCY, введенное в Форме Параметров во время выполнения, перезаписывает любое значение CURRENCY, введенное в командной строке.

THOUSANDS

Символ тысяч для использования в числовых форматах.

Опции: 	Любой допустимый алфавитно-цифровой символ.

Стр. 1-24

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра THOUSANDS значение по умолчанию в поле Initial Value окна свойств Parameter. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Значение THOUSANDS, введенное в Форме Параметров во время выполнения, перезаписывает любое значение THOUSANDS, введенное в командной строке.

DECIMAL

Десятичный символ для использования в числовых форматах.

Опции: 	Любой допустимый алфавитно-цифровой символ.

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра DECIMAL значение по умолчанию в поле Initial Value окна свойств Parameter. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Значение DECIMAL, введенное в Форме Параметров во время выполнения, перезаписывает любое значение DECIMAL, введенное в командной строке.

READONLY

Требует в отчете согласованности по чтению по нескольким запросам. Во время доступа к данным из ORACLE согласованность по чтению выполняется оператором SET TRANSACTION READ ONLY (дополнительную информацию о SET TRANSACTION READ ONLY вы найдете в ORACLE7 Server SQL Language Reference Manual).

Опции: 	YES требует согласованности по чтению

NO означает не предоставлять согласованности по чтению.

По умолчанию: NO

Правила:

Нижеприведенный список показывает порядок событий при исполнении отчета. Обратите внимание, где происходит SET TRANSACTION READONLY.

Перед срабатыванием триггера Формы.

Появляется Форма Параметров во время выполнения (если не подавлена).
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После срабатывания триггера Формы.

“Компилируется” Отчет.

Перед срабатыванием триггера Отчета и анализом запросов.

Исполняется SET TRANSACTION READONLY (если определен через аргумент READONLY или установку).

Отчет исполняется и срабатывает триггер Между Страницами для каждой страницы, кроме первой. (Заметьте, что при форматировании отчета данные могут извлекаться в любое время.)

Примечание: В течение этого времени вследствие любого из нижеследующего - выхода пользователя посредством DDL, SRW.DO_SQL с DDL или если ONFAILURE=COMMIT, могут произойти COMMITы и отчет оканчивается неудачно.

Для окончания транзакции исполняется COMMIT (если указано READONLY).

После срабатывания триггера Отчет.

Исполняется COMMIT/ROLLBACK/NOACTION на основании того, что указано через аргумент ONSUCCESS или установкой.

Предупреждение: В пунктах с 1.4 до 1.8 избегайте операторов DDL, которые могут модифицировать таблицы, на которых базируется отчет. Пункт 1.3 производит мгновенный снимок таблиц и этот снимок должен оставаться действительным во все время исполнения отчета. В пунктах с 1.6 до 1.8 избегайте операторов DМL, которые могут модифицировать содержимое таблиц, на которых базируется отчет.
 
Запросы могут исполняться в любом порядке, 
что
 делает операторы DМL ненадежными (если только 
они 
не исполняются на таблицах, не используемых этим отчетом).

Предупреждение: Если вы указываете READONLY, то вы должны избегать с ним DDL. Когда вы исполняете оператор DDL (напр., через SRW.DO_SQL или через выход пол
ь
зователя), то автоматически выдается COMMIT. Если вы используете READONLY, то это преждевременно окончит транзакцию, начатую SET TRANSACTION READONLY.

Это ключевое слово применимо только для отчетов, использующих несколько запросов, потому что для отчетов с одним запросом ORACLE автоматически предоставляет согласованность по чтению, без блокировки.

LOGFILE

Имя файла, в который отсылается вывод File->Print Screen. Если указанный файл уже существует, то вывод 
будет 
к нему 
добавлен. Это ключевое слово используется только в символьном режиме.

Опции: 	Любое допустимое имя файла.

По умолчанию: dfltrep.log в текущем директории.
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BUFFERS

Размер кэша виртуальной памяти в килобайтах.

Примечание: Чтобы обеспечить достаточно места для выполнения своего отчета, но не настолько много, чтобы занять слишком много системных ресурсов, вы должны настроить эту установку.

Опции: 	Число от 1 до 9,999. Для некоторых операционных систем верхний предел может быть ниже. Дополнительную информацию см. в Developer/2000 Installation Guidе.

По умолчанию: 640К

Правила:

Если эта установка изменяется в течение вашего сеанса, то изменение не действует до тех пор, пока отчет не будет выполняться в следующий раз.

BATCH

Подавляет весь терминальный ввод и вывод, чтобы выполнять отчеты без вмешательства пользователя. BATCH=YES дает вам возможность выполнять отчет, не выводя интерфейс R25RUN. Чтобы выполнять отчеты в фоновом режиме, см. “BACKGROUND” на стр. 1-31.

Опции: 	YES подавляет весь терминальный ввод и вывод.

NO разрешает специальный терминальный ввод и вывод.

По умолчанию: NO

Правила:

Если BATCH=YES, то сообщения об ошибках отсылаются на Sysout. Дополнительную информацию о Sysout см. в “DESNAME” на стр. 1-21.

Если BATCH=YES, то PARAMFORM=YES недопустимо, так как бессмысленно выводить Форму Параметров во время выполнения в пакетном режиме.

Если BATCH=NO и вы используете R25RUN с символьным режимом, то отчеты с двоичным отображением выполняться не могут. (Невозможно выполнять отчет с двоичным отображением на экране устройства с символьным режимом.)

Если BATCH=YES, MODE=BITMAP
 
и вы используете R25RUN с символьным режимом, то вы не можете выполнять отчет с символьным режимом.
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PAGESIZE

Размеры физической страницы (т.е. размеры страницы, выводимой на принтере).

Опции: 	Любые допустимые размеры страницы формы: ширина страницы х высота страницы, где ширина страницы и высота страницы - ноль или более. Максимальная ширина/высота зависит от единицы измерения. Для дюймов максимальная ширина/ высота 512 дюймов. Для сантиметров это 1312 сантиметров. Для точек это 36,864 точек.

Учитывайте, что страница должна быть достаточно большой, чтобы вместить отчет. Например, если кадр в отчете превышает размер страницы, то отчет выполняться не будет.

По умолчанию: Для двоичного отображения 8.5 х 11 дюймов. Для символьного режима 80 х 66 символов. Если отчет был спроектирован для символьного режима и выполняется или преобразуется на двоичное отображение, то для определения размеров страницы, если они не указаны, используется следующая формула: (размер страницы по умолчанию * размер символьной страницы)/размер символьной страницы по умолчанию. Например, если размер символьной страницы 80 х 20, то размер страницы с двоичным отображением будет: (8.5*80)/80х(11*20)/66=8.5х3.33.

Правила:

Предупреждение: На некоторых принтерах область печати физической страницы ограничена. Например, принтер может принимать лист бумаги размерами 8.5 х 11 дюймов, но печатать способен только на области 8 х 10.5 дюйма. Если в Oracle Reports вы определите ширину страницы х высоту страницы больше, чем разрешает печатная область принтера, может произойти обрезание в выводе вашего отчета. Во избежание обрезания вы можете или увеличить печатную область принтера (если ваша операционная система это позволяет), или установить ширину страницы х высоту страницы на размер печатной области.

Если это ключевое слово используется, то оно перезаписывает размеры страницы в определении отчета.

Значение PAGESIZE, введенное в Форме Параметров во время выполнения, перезапишет любое значение PAGESIZE, введенное в командной строке.
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PROFILE

Имя файла, в котором вы хотите сохранить статистику быстродействия исполнения отчета. Если вы укажете имя файла, то Oracle Reports вычислит статистику истекшего и потраченного CPU времени при исполнении отчета. PROFILE вычисляет следующую статистику:

TOTAL ELAPSED TIME - количество времени, которое проходит между моментом за
пуска
 вами R25RUN и моментом окончания выполнения отчета. TOTAL ELAPSED TIME - это сумма Oracle Reports Time и ORACLE Time.

Oracle Reports Time - количество времени, проведенное в Oracle Reports.

ORACLE Time - количество времени, проведенное в базе данных, оно состоит из следующего:

UPI - количество времени, израсходованного на выполнение таких действий, как соединение с базой данных, анализ SQL и извлечение данных.

SQL- количество времени, израсходованного на выполнение SRW.DO_SQL.

TOTAL CPU Time used by process - время CPU, потраченное на выполнение отчета.

Примечание: Для некоторых операционных систем время Oracle Reports включает в себя время базы данных, потому что база данных включается в процесс Oracle Reports. Дополнительную информацию см. в Developer/2000 Installation Guidе.

Опции: 	Любое допустимое имя файла в текущем директории.

RUNDEBUG

Хотите ли вы дополнительную проверку на логические ошибки в отчете. RUNDEBUG проверяет и такое, что не является ошибками, но может привести к нежелательному выводу. RUNDEBUG проверяет следующее:

кадры и повторяющиеся кадры, которые перекрываются, но не включают в себя другой объект. Это может привести к перезаписи одних объектов другими.

объекты расположения со странично-зависимыми ссылками, не имеющие фиксированных размеров. Oracle Reports сделает размеры таких объектов фиксированными независимо от свойств Vertical и Horizontal Sizing. Дополнительную информацию см. в “Размере по вертикали” на стр. 8-20.

связные переменные, к которым в PL/SQL производится обращение с неправильной частотой.

отчет в символьном режиме или с двоичным отображением, а среда наоборот.

Опции:	YES означает выполнять дополнительную проверку на ошибки во время выполнения.
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NO означает не выполнять дополнительную проверку на ошибки во время выполнения.

По умолчанию: NO

ONSUCCESS

Хотите ли вы, чтобы по окончании исполнения отчета выполнялся COMMIT или ROLLBACK.

Опции:	COMMIT означает, что после исполнения отчета будет выполняться COMMIT.

ROLLBACK означает, что после исполнения отчета будет выполняться ROLLBACK.

NOACTION означает, что после исполнения отчета не будет делаться ничего.

По умолчанию: COMMIT, если присутствует USERID.

NOACTION, если вызывается из внешнего источника (напр., Oracle Forms) без USERID.

Правила:

COMMIT или ROLLBACK выполняется для ONSUCCESS после срабатывания триггера После Отчета. До него могут происходить другие COMMITы или ROLLBACKи. Дополнительную информацию см. в “READONLY” на стр. 1-24.

ONFAILURE 

Хотите ли вы, чтобы в случае ошибки и незавершения отчета выполнялся COMMIT или ROLLBACK.

Опции:	COMMIT означает, что в случае невыполнения отчета будет выполняться COMMIT.

ROLLBACK означает, что в случае невыполнения отчета будет выполняться ROLLBACK.

NOACTION означает, что в случае невыполнения отчета не будет делаться ничего.

По умолчанию: ROLLBACK, если присутствует USERID.

NOACTION, если вызывается из внешнего источника (напр., Oracle Forms) без USERID.

Правила:

COMMIT или ROLLBACK 
после невыполнения отчета
 
выполняется для ONFAILURE
. До него могут происходить другие COMMITы или ROLLBACKи. Дополнительную информацию см. в “READONLY” на стр. 1-24.
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KEYIN

Имя файла нажатий клавиш, который вы хотите исполнить во время выполнения. KEYIN используется для выполнения файлов нажатий клавиш, созданных с помощью KEYOUT.

Предупреждение: Так как KEYIN используется для выполнения файла нажатий клавиш, он уместен только при выполнении в среде с символьным режимом.

Опции: 	Любое допустимое имя файла клавиш в текущем директории.



KEYOUT

Имя файла нажатий клавиш, в который Oracle Reports должен записать все ваши нажатия клавиш. Тогда для исполнения файла нажатий клавиш вы можете использовать KEYIN. KEYOUT и KEYIN используются в тех случаях, когда у вас есть определенные нажатия клавиш, производимые при каждом выполнении отчета. Они также используются для ц
е
лей отладки.

Предупреждение: Так как KEYOUT используется для создания файла нажатий клавиш, он уместен только при выполнении в среде с символьным режимом.

Опции: 	Любое допустимое имя файла



ERRFILE

Имя файла, в который Oracle Reports должен сохранять все сообщения об ошибках, выдаваемые во время исполнения вашего отчета.

Опции: 	Любое допустимое имя файла

LONGCHUNK

Размер (в килобайтах) приращений, в которых Oracle Reports извлекает значение колонки LONG. При извлечении значения LONG вы можете 
и
з-за ограничений по об
ъ
емам памяти
 
пожелать 
извлекать его в приращениях, а не все сразу
. LONGCHUNK применяется только к ORACLE7.

Опции: 	Число от 1 до 9,999. Для некоторых операционных систем верхний предел может быть ниже. Дополнительную информацию см. в Developer/2000 Installation Guidе.

По умолчанию: 10К

ORIENTATION

Управляют направлением, в котором будут печататься страницы в принтере.

Опции: 	DEFAULT означает использовать для ориентации текущую установку принтера.

LANDSCAPE

PORTRAIT

По умолчанию: DEFAULT
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Правила:

Если для отчета в символьном режиме ORIENTATION=LANDSCAPE, вы должны обеспечить в своем файле определения принтера наличие оператора landscape. Дополнительную информацию см. в “Синтаксисе файла определения принтера” на стр. В-3.

BACKGROUND

Указывает, должен ли отчет выполняться в фоновом режиме. Если BACKGROUND установлено на YES, то порождается другой процесс. Эта опция используется в случае, если вы во время выполнения отчета хотите поработать над чем-то еще в приоритетном режиме.

Дополнительная информация: В Windows указание BACKGROUND=YES означает, что отчет пойдет в очередь Oracle Reports Server.

Опции:	YES

NO

По умолчанию: NO

Правила:

BACKGROUND=YES не поддерживается для BATCH=YES, DESTYPE=SCREEN или PREVIEW, или R25DES.

Если вы выполняете отчет из Oracle Reports Runtime (т.е. не из командной строки или SRW.RUN_REPORT), то перед выполнением отчета вы должны зафиксировать изменения в базе данных, произведенные в триггерах Перед Формой, После Формы и Проверка Допустимости. При выполнении таким способом эти триггеры будут совместно использовать соединение с базой данных родительского процесса. Когда будет действительно исполняться отчет, он установит свое собственное соединение с базой данных.

MODE

Указывает, выполнять ли отчет в символьном режиме или с двоичным отображением. Это дает вам возможность выполнять отчет с символьным режимом из Oracle Reports с двоичным отображением и наоборот. Например, если вы хотите послать отчет на принтер PostScript с терминала (напр., vt220), то вы можете вызвать R25RUN с символьным режимом и запустить отчет с mode=bitmap.

Дополнительная информация: В Windows указание mode=character означает, что для производства вывода ASCII с возможностью редактирования будет использоваться драйвер Oracle Reports ASCII.

Опции:	BITMAP

DEFAULT означает выполнить отчет в том режиме, который использует текущий исполняемый модуль.

CHARACTER
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По умолчанию: DEFAULT

PRINTJOB

Указывает, должно ли выводиться на экран диалоговое окно Print Job перед выполнением отчета.

Опции:	NO

YES

По умолчанию: YES

Правила:

Если отчет выполняется как порожденный процесс (т.е. один исполняемый модуль, такой как R25RUN, вызывается из другого исполняемого модуля, такого как R25DES), то диалоговое окно Print Job 
независимо от PRINTJOB
 
появляться не будет
.

Если DESTYPE=MAIL, то диалоговое окно Print Job 
независимо от PRINTJOB
 
появляться не будет
.

<PARAM>

Параметр, являющийся частью определения отчета. Указываемое вами значение используется для значения этого параметра.

Опции:	Любое допустимое значение для этого параметра.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESTYPE. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Примеры:

Следующее 
ниже 
- пример указания значения параметра R25RUN:

r25run scott/tiger myparam=100 yourparam=‘Sratford’ theirparam=‘10-DEC-93’

Правила:

В Форме Параметров во время выполнения вы можете перезаписать значение по умолчанию. Дополнительную информацию см. в “Форме Параметров во время выполнения” (на стр. 9-2).

Значения аргументов могут быть в одиночных или двойных кавычках. Действие одиночных или двойных кавычек специфично для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе по вашей операционной системе.

Если, используя ключевое слово REPORT, вы указываете выполняемый файл(ы), то значения PARAM будут проверяться на допустимость, используя установки, указанные для каждого параметра (напр., Input Mask, Validation Trigger) в каждом отчете(ах).
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Если вы не указываете выполняемый
(е)
 файл(ы), используя ключевое слово REPORT, то значение PARAM не анализируется, или не проверяется на допустимость, потому что эти параметры могут обращаться к таким, которые еще не определены.

TRACEFILE

Имя файла, в который Oracle Reports записывает информацию отслеживания.

Опции:	Любое допустимое имя файла.

По умолчанию: trace.dat

Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

Если вы укажете LOGFILE или ERRFILE, а также TRACEFILE, то вся информация отслеживания будет помещаться в самый последний указанный файл. Например, предположим, вы укажете следующее:

r25run MODULE=order_entry USERID=scott/tiger TRACEFILE=trace.log LOGFILE=mylog.log ERRFILE=err.log

В этом случае вся указанная информация отслеживания будет помещаться в err.log, потому что это последний файл, указанный в команде R25RUN.

TRACEMODE

Обозначает, должен ли Oracle Reports добавлять информацию отслеживания к файлу или перезаписывать весь файл.

Опции:	TRACE_APPEND добавляет новую информацию в конец файла.

TRACE_REPLACE перезаписывает файл.

По умолчанию: TRACE_APPEND

Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

TRACEOPTS

Обозначает информацию отслеживания, которую вы хотите записать в файл.

Опции:	Список опций в скобках означает, что вы хотите использовать все 
опции
,
 
заключенные
 в скобки
. Например, trace_opts=(trace_app, trace_prf) означает, что вы хотите применить TRACE_APP и TRACE_PRF.


TRACE_ALL
 означает записывать в файл всю возможную информацию отслеживания.

Стр. 1-34


TRACE_APP
 означает записывать в файл информацию отслеживания по всем объектам отчета.


TRACE_ERR
 означает перечислить в файле отслеживания сообщения об ошибках и предупреждения.


TRACE_PLS
 означает записывать в файл информацию отслеживания по всем объектам PL/SQL.


TRACE_PRF
 означает записывать в файл статистику быстродействия.


TRACE_SQL
 означает записывать в файл информацию отслеживания по всем SQL.


TRACE_TMS
 означает вводить штемпель времени для каждого элемента в файле отслеживания.

По умолчанию: 
TRACE_ALL


Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

AUTOCOMMIT

Указывает, должны ли автоматически фиксироваться изменения в базе данных (напр., CREATE). Учтите, что некоторые не-ORACLE базы данных (напр., SQL Server) требуют AUTOCOMMIT=YES.

Опции:	YES

NO

По умолчанию: NO

NONBLOCKSQL

В Windows указывает, разрешать ли исполняться другим программам во время извлечения Oracle Reports данных из базы данных. Это ключевое слово игнорируется на платформах, иных чем Windows (напр., Motif).

Опции:	YES

NO

По умолчанию: YES
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R25DES



R25DES вызывает дизайнер Oracle Reports для создания/поддержки отчетов.

Синтаксис:

r25des [ [keyword=]value ] ...

где следующее - допустимые аргументы keyword=value:

[ [MODULE|REPORT=]modulename ]

[ [USERID=]userid ]

[ [PARAMFORM=]{yes|no} ]

[ [CMDFILE=]filename ]

[ [ARRAYSIZE=]n ]

[ [DESTYPE=]{screen|file|printer|mail}]

[ [DESNAME=]desname ]

[ [DESFORMAT=]desformat ]

[ [COPIES=]n ]

[ [CURRENCY=]currency_symbol ]

[ [THOUSANDS=]thousands_symbol ]

[ [DECIMAL=]decimal_symbol ]

[ [READONLY=]{yes|no} ]

[ [BUFFERS=]n ]

[ [PAGESIZE=]width x height ]

[ [PROFILE=]profiler_file ]

[ [RUNDEBUG=]{yes|no} ]

[ [ONSUCCESS=]COMMIT|ROLLBACK|NOACTION]

[ [ONFAILURE=]COMMIT|ROLLBACK|NOACTION]

[ [ERRFILE=]error_file ]

[ [LONGCHUNK=]n ]

[ [ACCESS=]{file|database} ]

[ [ORIENTATION=]DEFAULT|LANDSCAPE|PORTRAIT ]

[ [BACKGROUND=]{yes|no} ]

[ [MODE=]BITMAP|CHARACTER|DEFAULT ]

[ [PRINTJOB] {yes|no} ]

[ <param>=value ]

[ [TRACEFILE=]tracefile ]

[ [TRACEMODE=]{TRACE_APPEND|TRACE_REPLACE} ]

[ [TRACEOPTS=]{TRACE_ERR|TRACE_PRF|TRACE_BRK|TRACE_APP|TRACE_PLS|TRACE_SQL| TRACE_TMS| TRACE_ALL|(opt1, opt2, ...)} ]

[ [AUTOCOMMIT=]{yes|no} ]

[ [NONBLOCKSQL=]{yes|no} ]
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MODULE/REPORT

Модуль (отчет, внешний запрос или внешняя библиотека PL/SQL), который вы хотите открыть в дизайнере. Если вы не укажете отчет, пользуясь MODULE/REPORT, то Oracle Reports запустится с открытым определением нового отчета.

Опции:	Любое допустимое имя отчета, внешнего запроса или внешней библиотеки PL/SQL. Oracle Reports будет искать этот модуль в месте, указанном ключевым словом ACCESS. Если ACCESS не указано, то Oracle Reports будет пользоваться своим порядком поиска путей к файлам. Дополнительную информацию о порядке поиска путей к файлам см. в “Способе поиска файлов” на стр. 18-9. Если модуль не обнаружен, то Oracle Reports запустится без открытия указанного модуля.

Правила:

Если вы открываете отчет с символьным режимом через R25DES с двоичным отображением, то Oracle Reports выведет на экран предупреждение, затем откроет отчет, используя размер страницы 8.5”х11” и размер формы 7”х6”.

USERID

Ваше вхождение в базу данных. Дополнительную информацию см. во “Вхождении в базу д
анных” на стр. 1-7.

PARAMFORM

При исполнении отчета выводит Форму Параметров во время выполнения. Дополнительную информацию о Форме Параметров во время выполнения см. в “Форме Параметров во время выполнения” на стр. 9-2.

Опции: 	
yes
 означает вывод Формы.


no
 означает подавление Формы.

По умолчанию: 
yes


CMDFILE

Файл, содержащий аргументы для команды R25DES. Эта опция дает вам возможность запускать отчет на выполнение без необходимости указывать большое количество аргументов при каждом вызове R25DES.

Опции: 	Любой допустимый командный файл.

Правила:

Командный файл может обращаться к другому командному файлу.

Синтаксис командного файла для аргументов R25DES идентичен используемому в командной строке.
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Значения, вводимые в командной строке, подавляют значения, указанные в командном файле. Например, предположим, что вы в командной строке указали R25DES с COPIES равным 1 и CMDFILE равным RUNONE (командный файл). В RUNONE COPIES установлено на 2. В таком случае будет сгенерирована только одна копия отчета. Дополнительную информацию см. в “Правилах синтаксиса командной строки” на стр. 1-4.

Аргументы для этого ключевого слова могут быть специфичны для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guide для вашей операционной системы.

ARRAYSIZE

Размер массива в килобайтах для использования в обработке массива ORACLE.

Опции: 	Число от 1 до 9,999. Это означает, что такое количество килобайтов памяти Oracle Reports может использовать на каждый запрос в вашем отчете.

По умолчанию: Размер массива по умолчанию 10К. Подробно
 
об
 обработк
е
 массива ORACLE см. в ORACLE7 Server Administrator’s Guide.

DESTYPE

Тип целевого устройства, которое будет принимать вывод отчета.

Опции: 	Screen направляет вывод в Предпросмотровщик.

File сохраняет вывод в файл, названный в DESNAME (следующее рассматриваемое ключевое слово).

Printer направляет вывод на принтер, названный в DESNAME (следующее рассматриваемое ключевое слово).

Preview также направляет вывод в Предпросмотровщик для интерактивного просмотра. Но Предпросмотровщик заставляет форматировать вывод как вывод PostScript. Чтобы определить какие шрифты принтера использовать для вывода на экран, Предпросмотровщик будет использовать DESNAME.

Mail отсылает вывод пользователям Oracle*Mail, указанным в DESNAME. Если в вашей системе Oracle*Mail не инсталлирован
 или система не является узлом Oracle*Mail, то будет возвращена ошибка. Отчет отсылается как подсоединенный файл, но не прямо как почтовое сообщение.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESTYPE. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.
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Правила:

Во время пользования R25DES Sysout не является допустимой опцией для DESTYPE. Sysout может использоваться только с R25RUN когда BATCH=YES.

Если вы установите DESTYPE на Printer, File, или Mail, то после вашего согласия с Формой Параметров во время выполнения, если только оно не подавлена, появится диалоговое окно Print Job. После вашего согласия с диалоговым окном Print Job отчет исполняется и вывод отсылается на принтер (указанный в File->Choose Printer), в файл или почтовому идентификатору. (Если DESTYPE отлич
е
н
 от Printer, File, или Mail, то отчет исполняется после вашего согласия с Формой Параметров во время выполнения.) Внешний вид этого диалогового окна меняется в зависимости от операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе.

В некоторых случаях этот параметр может быть перезаписан вашей операционной системой. Дополнительную информацию см. в Developer/2000 Installation Guidе.

Все значения DESTYPE 
в каждой операционной системе
 
не поддерживаются
. Дополнительную информацию см. в Developer/2000 Installation Guidе.

DESNAME

Имя файла, принтера или имя пользователя Oracle*Mail (или список рассылки), которому будет отсылаться вывод отчета. Чтобы отослать вывод отчета пользователю Oracle*Mail, укажите имя этого пользователя, как вы это делаете в Oracle*Mail. Вы можете указать несколько имен пользователей, заключив их в скобки и отделяя друг от друга запятыми (напр., (<name>,<name>,...<name>)).

Опции:	Любое допустимое имя файла, имя принтера или идентификатор пользователя Oracle*Mail, не превышающее длиной 1К. Для имен принтеров вы необязательно можете указывать порт. Например:

DESNAME=
<
printer_name>,LPT1;

DESNAME=
<
printer_name>,FILE;

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESNAME. Если DESTYPE=FILE и DESNAME - пустая цепочка, то во время выполнения оно устанавливется на <reportname>.lis. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен на Screen.

Если DESTYPE установлен на Preview, то Oracle Reports для определения того, какие шрифты принтера использовать для вывода на экран, использует DESNAME.
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Аргумент(ы) для этого ключевого слова могут быть чувствительны к регистру, что зависит от вашей операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

В некоторых случаях этот параметр может быть перезаписан вашей операционной системой. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

DESFORMAT


Е
сли DESTYPE установлен на File, 
то в
 средах с двоичным отображением
 
указывает на драйвер принтера. В средах с символьным режимом указывает на характеристики принтера, названного в DESNAME.

Опции:	Любой допустимый целевой формат, не превышающий длиной 1К. Примерами допустимых значений для этого ключевого слова могут быть hpl, hplwide, dec, decwide, decland, dec180, dflt, wide и т.д. Список допустимых целевых форматов попросите у вашего системного администратора.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESFORMAT. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45. 
Е
сли
 DESFORMAT пустой или установлен на dflt, 
то д
ля Oracle 
Reports с двоичным отображением
 
используется текущий драйвер принтера, выбранный в Choose Printer. Если в Choose Printer ничего не выбрано, то по умолчанию используется PostScript.

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен на Screen.

Аргумент(ы) для этого ключевого слова могут быть чувствительны к регистру, что зависит от вашей операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

COPIES

Количество копий отчета для печати.

Опции: 	Любое допустимое целое число от 1 до 9,999.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра COPIES. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Это ключевое слово игнорируется, если DESTYPE установлен не на Printer.

Если COPIES в Форме Параметров во время выполнения оставлен пустым, то по умолчанию равен одному.
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CURRENCY

Денежный знак для использования в числовых форматах.

Опции: 	Любая допустимая алфавитно-цифровая цепочка, не превышающая длиной 1К.

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра CURRENCY значение по умолчанию длиной до четырех символов в поле Initial Value окна свойств Parameter. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Значение CURRENCY, введенное в Форме Параметров во время выполнения, перезаписывает любое значение CURRENCY, введенное в командной строке.

THOUSANDS

Символ тысяч для использования в числовых форматах.

Опции: 	Любой допустимый алфавитно-цифровой символ.

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра THOUSANDS значение по умолчанию в поле Initial Value окна свойств Parameter. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Правила:

Значение THOUSANDS, введенное в Форме Параметров во время выполнения, перезаписывает любое значение THOUSANDS, введенное в командной строке.

DECIMAL

Десятичный символ для использования в числовых форматах.

Опции: 	Любой допустимый алфавитно-цифровой символ.

По умолчанию: Значение по умолчанию для ORACLE определяется средствами поддержки национальных языков ORACLE. Вы 
можете 
также 
установить для параметра DECIMAL значение по умолчанию в поле Initial Value окна свойств Parameter. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.
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Правила:

Значение DECIMAL, введенное в Форме Параметров во время выполнения, перезаписывает любое значение DECIMAL, введенное в командной строке.



READONLY

Требует в отчете согласованности по чтению по нескольким запросам. Во время доступа к данным из ORACLE согласованность по чтению выполняется оператором SET TRANSACTION READ ONLY (дополнительную информацию о SET TRANSACTION READ ONLY вы найдете в ORACLE7 Server SQL Language Reference Manual).

Опции: 	YES требует согласованности по чтению

NO означает не предоставлять согласованности по чтению.

По умолчанию: NO

Правила:

Нижеприведенный список показывает порядок событий при исполнении отчета. Обратите внимание, где происходит SET TRANSACTION READONLY.

Перед срабатыванием триггера Формы.

Появляется Форма Параметров во время выполнения (если не подавлена).

После срабатывания триггера Формы.

“Компилируется” Отчет.

Перед срабатыванием триггера Отчета и анализом запросов.

Исполняется SET TRANSACTION READONLY (если определен через аргумент READONLY или установку).

Отчет исполняется и срабатывает триггер Между Страницами для каждой страницы, кроме первой. (Заметьте, что при форматировании отчета данные могут извлекаться в любое время.)

Примечание: В течение этого времени вследствие любого из нижеследующего - выхода пользователя посредством DDL, SRW.DO_SQL с DDL или если ONFAILURE=COMMIT, могут произойти COMMITы и отчет оканчивается неудачно.

Для окончания транзакции исполняется COMMIT (если указано READONLY).

После срабатывания триггера Отчет.

Исполняется COMMIT/ROLLBACK/NOACTION на основании того, что указано через аргумент ONSUCCESS или установкой.
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Предупреждение: В пунктах с 1.4 до 1.8 избегайте операторов DDL, которые могут модифицировать таблицы, на которых базируется отчет. Пункт 1.3 производит мгновенный снимок таблиц и этот снимок должен оставаться действительным во все время исполнения отчета. В пунктах с 1.6 до 1.8 избегайте операторов DМL, которые могут модифицировать содержимое таблиц, на которых базируется отчет.
 
Запросы могут исполняться в любом порядке, который делает операторы DМL ненадежными (если только 
они 
не исполняются на таблицах, не используемых этим отчетом).

Предупреждение: Если вы указываете READONLY, то вы должны избегать с ним DDL. Когда вы исполняете оператор DDL (напр., через SRW.DO_SQL или через выход пол
ь
зователя), то автоматически выдается COMMIT. Если вы используете READONLY, то это преждевременно окончит транзакцию, начатую SET TRANSACTION READONLY.

Это ключевое слово применимо только для отчетов, использующих несколько запросов, потому что для отчетов с одним запросом ORACLE автоматически предоставляет согласованность по чтению, без блокировки.

BUFFERS

Размер кэша виртуальной памяти в килобайтах.

Примечание: Чтобы обеспечить достаточно места для выполнения своего отчета, но не настолько много, чтобы занять слишком много системных ресурсов, вы должны настроить эту установку.

Опции: 	Число от 1 до 9,999. Для некоторых операционных систем верхний предел может быть ниже. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

По умолчанию: 640К

Правила:

Если эта установка изменяется в течение вашего сеанса, то изменение не действует до тех пор, пока отчет не будет выполняться в следующий раз.

PAGESIZE

Размеры физической страницы (т.е. размеры страницы, выводимой на принтере).

Опции: 	Любые допустимые размеры страницы формы: ширина страницы х высота страницы, где ширина страницы и высота страницы - ноль или более. Максимальная ширина/высота зависит от единицы измерения. Для дюймов максимальная ширина/
высота 512 дюймов. Для сантиметров это 1312 сантиметров. Для точек это 36,864 точек.
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Учитывайте, что страница должна быть достаточно большой, чтобы вместить отчет. Например, если кадр в отчете превышает размер страницы, то отчет выполняться не будет.

По умолчанию: Для двоичного отображения 8.5 х 11 дюймов. Для символьного режима 80 х 66 символов. Если отчет был спроектирован для символьного режима и выполняется или преобразуется на двоичное отображение, то для определения размеров страницы, если они не указаны, используется следующая формула: (размер страницы по умолчанию * размер символьной страницы)/размер символьной страницы по умолчанию. Например, если размер символьной страницы 80 х 20, то размер страницы с двоичным отображением будет: (8.5*80)/80х(11*20)/66=8.5х3.33.

Правила:

Предупреждение: На некоторых принтерах область печати физической страницы ограничена. Например, принтер может принимать лист бумаги размерами 8.5 х 11 дюймов, но печатать способен только на области 8 х 10.5 дюйма. Если в Oracle Reports вы определите ширину страницы х высоту страницы больше, чем разрешает печатная область принтера, может произойти обрезание в выводе вашего отчета. Во избежание обрезания вы можете или увеличить печатную область принтера (если ваша операционная система это позволяет), или установить ширину страницы х высоту страницы на размер печатной области.

Если это ключевое слово используется, то оно перезаписывает размеры страницы в определении отчета.

Значение PAGESIZE, введенное в Форме Параметров во время выполнения, перезапишет любое значение PAGESIZE, введенное в командной строке.

PROFILE

Имя файла, в котором вы хотите сохранить статистику быстродействия исполнения отчета. Если вы укажете имя файла, то Oracle Reports вычислит статистику истекшего и потраченного CPU времени при исполнении отчета. PROFILE вычисляет следующую статистику:

TOTAL ELAPSED TIME - количество времени, которое проходит между моментом задания вами R25DES и моментом окончания выполнения отчета. TOTAL ELAPSED TIME - это сумма Oracle Reports Time и ORACLE Time.

Oracle Reports Time - количество времени, проведенное в Oracle Reports.
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ORACLE Time - количество времени, проведенное в базе данных, оно состоит из следующего:

UPI - количество времени, израсходованного на выполнение таких действий, как соединение с базой данных, анализ SQL и извлечение данных.

SQL- количество времени, израсходованного на выполнение SRW.DO_SQL.

TOTAL CPU Time used by process - время CPU, потраченное на выполнение отчета.

Примечание: Для некоторых операционных систем время Oracle Reports включает в себя время базы данных, потому что база данных включается в процесс Oracle Reports. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

Опции: 	Любое допустимое имя файла в текущем директории.

RUNDEBUG

Хотите ли вы дополнительную проверку на логические ошибки в отчете. RUNDEBUG проверяет и такое, что не является ошибками, но может привести к нежелательному выводу. RUNDEBUG проверяет следующее:

кадры и повторяющиеся кадры, которые перекрываются, но не включают в себя другой объект. Это может привести к перезаписи одних объектов другими.

объекты расположения со странично-зависимыми ссылками, не имеющие фиксированных размеров. Oracle Reports сделает размеры таких объектов фиксированными независимо от свойств Vertical и Horizontal Sizing. Дополнительную информацию см. в “Размере по вертикали” на стр. 8-20.

связные переменные, к которым в PL/SQL производится обращение с неправильной частотой.

Опции:	
YES
 означает выполнять дополнительную проверку на ошибки во время выполнения.


NO
 означает не выполнять дополнительную проверку на ошибки во время выполнения.

По умолчанию: 
YES


ONSUCCESS

Хотите ли вы, чтобы по окончании исполнения отчета выполнялся COMMIT или ROLLBACK.

Опции:	
COMMIT
 означает, что после исполнения отчета будет выполняться COMMIT.


ROLLBACK
 означает, что после исполнения отчета будет выполняться ROLLBACK.


NOACTION
 означает, что после исполнения отчета не будет делаться ничего.

По умолчанию: 
COMMIT
, если присутствует USERID.
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NOACTION
, если вызывается из внешнего источника (напр., Oracle Forms) без USERID.

Правила:

COMMIT или ROLLBACK выполняется для ONSUCCESS после срабатывания триггера После Отчета. До него могут происходить другие COMMITы или ROLLBACKи. Дополнительную информацию см. в “READONLY” на стр. 1-41.

ONFAILURE

Хотите ли вы, чтобы в случае ошибки и незавершения отчета выполнялся COMMIT или ROLLBACK.

Опции:	
COMMIT
 означает, что в случае невыполнения отчета будет выполняться COMMIT.


ROLLBACK
 означает, что в случае невыполнения отчета будет выполняться ROLLBACK.


NOACTION
 означает, что в случае невыполнения отчета не будет делаться ничего.

По умолчанию: 
ROLLBACK
, если присутствует USERID.


NOACTION
, если вызывается из внешнего источника (напр., Oracle Forms) без USERID.

Правила:

COMMIT или ROLLBACK выполняется для ONFAILURE после невыполнения отчета. До него могут происходить другие COMMITы или ROLLBACKи. Дополнительную информацию см. в “READONLY” на стр. 1-41.

ERRFILE

Имя файла, в который Oracle Reports должен 
записывать
 все сообщения об ошибках, выдаваемые во время исполнения вашего отчета.

Опции: 	Любое допустимое имя файла

LONGCHUNK

Размер (в килобайтах) приращений, в которых Oracle Reports извлекает значение колонки LONG. При извлечении значения LONG вы 
из-за ограничений по объ
емам памяти
 
можете пожелать извлекать его в приращениях, а не все
 сразу
. LONGCHUNK применяется только к ORACLE7.

Опции: 	Число от 1 до 9,999. Для некоторых операционных систем верхний предел может быть ниже. Дополнительную информацию см. в Developer/2000 Installation Guidе для вашей операционной системы.

По умолчанию: 10К
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ACCESS

Место, из которого должны открываться модули. 
Д
ля модуля, указанного в MODULE
,
 
Oracle Reports будет производить поиск в этом месте
. Если ACCESS не указан, то Oracle Reports для обнаружения файла будет использовать свой порядок поиска путей файлов. Информацию о порядке поиска путей файлов см. в “Способе поиска файлов” на стр. 18-9.

Опции: 	
FILE



DATABASE


По умолчанию: 
FILE


ORIENTATION

Управляют направлением, в котором будут печататься страницы в принтере.

Опции: 	
DEFAULT
 означает использовать для ориентации текущую установку принтера.


LANDSCAPE



PORTRAIT


По умолчанию: 
DEFAULT


Правила:

Если для отчета в символьном режиме ORIENTATION=LANDSCAPE, вы должны обеспечить в своем файле определения принтера наличие оператора landscape. Дополнительную информацию см. в “Синтаксисе файла определения принтера” на стр. В-3.




BACKGROUND

Указывает, должен ли отчет выполняться в фоновом режиме. BACKGROUND=YES для R25DES не поддерживается. Дополнительную информацию см. в “BACKGROUND” на стр. 1-31.

Опции	
YES



NO
 недопустим
ая опция
 для R25DES (
ошибка
?)

По умолчанию: 
NO


MODE

Указывает, выполнять ли отчет в символьном режиме или с двоичным отображением. Это дает вам возможность выполнять отчет с символьным режимом из Oracle Reports с двоичным отображением и наоборот. Например, если вы хотите послать отчет на принтер PostScript с терминала (напр., vt220), то вы можете вызвать R25RUN с символьным режимом и запустить отчет с mode=bitmap.

Дополнительная информация: В Windows указание mode=character означает, что для производства вывода ASCII с возможностью редактирования будет использоваться драйвер Oracle Reports ASCII.

Опции:	
BITMAP
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DEFAULT
 означает выполнить отчет в том режиме, который использует текущий исполняемый модуль.


CHARACTER


По умолчанию: 
DEFAULT


PRINTJOB

Указывает, должно ли 
перед выполнением отчета
 
выводиться на экран диалоговое окно Print Job
.

Опции:	
NO



YES


По умолчанию: 
YES


Правила:

Если отчет выполняется как порожденный процесс (т.е. один исполняемый модуль, такой как R25RUN, вызывается из другого исполняемого модуля, такого как R25DES), то диалоговое окно Print Job 
независимо от PRINTJOB
 
появляться не будет
.

Если DESTYPE=MAIL, то диалоговое окно Print Job 
независимо от PRINTJOB
 
появляться не будет
.

<PARAM>

Параметр, являющийся частью определения отчета. Указываемое вами значение используется для значения этого параметра.

Опции:	Любое допустимое значение для этого параметра.

По умолчанию: Берется из поля Initial Value окна свойств Parameter для параметра DESTYPE. Дополнительную информацию об окне свойств Parameter см. в “Свойствах параметров” на стр. 6-45.

Примеры:

Следующее 
ниже 
- пример указания значения параметра R25DES:

r25des scott/tiger myparam=100 yourparam=‘Sratford’ theirparam=‘10-DEC-93’

Правила:

В Форме Параметров во время выполнения вы можете перезаписать значение по умолчанию. Дополнительную информацию см. в “Форме Параметров во время выполнения” (на стр. 9-2).

Значения аргументов могут быть в одиночных или двойных кавычках. Действие одиночных или двойных кавычек специфично для операционной системы. Дополнительную информацию см. в Developer/2000 Installation Guidе по вашей операционной системе.
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Значение PARAM не анализируется, или не проверяется на допустимость, потому что эти параметры могут обращаться к таким, которые еще не определены.

TRACEFILE

Имя файла, в который Oracle Reports записывает информацию отслеживания.

Опции:	Любое допустимое имя файла.

Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

Если вы укажете ERRFILE, а также TRACEFILE, то вся информация отслеживания будет помещаться в самый последний указанный файл. Например, предположим, вы укажете следующее:

r25des USERID=scott/tiger TRACEFILE=trace.log ERRFILE=err.log

В этом случае вся указанная информация отслеживания будет помещаться в err.log, потому что это последний файл, указанный в команде R25DES.

TRACEMODE

Обозначает, должен ли Oracle Reports добавлять информацию отслеживания к файлу или перезаписывать весь файл.

Опции:	
TRACE_APPEND
 добавляет новую информацию в конец файла.


TRACE_REPLACE
 перезаписывает файл.

По умолчанию: 
TRACE_APPEND


Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

TRACEOPTS

Обозначает информацию отслеживания, которую вы хотите записать в файл.

Опции:	Список опций в скобках означает, что вы хотите использовать все 
опции
,
 
заключенные
 в скобках
. Например, trace_opts=(trace_app, trace_prf) означает, что вы хотите применить TRACE_APP и TRACE_PRF.


TRACE_ALL
 означает записывать в файл всю возможную информацию отслеживания.


TRACE_APP
 означает записывать в файл информацию отслеживания по всем объектам отчета.
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TRACE_BRK
 означает список точек прерывания в файле отслеживания.


TRACE_ERR
 означает перечислить в файле отслеживания сообщения об ошибках и предупреждения.


TRACE_PLS
 означает записывать в файл информацию отслеживания по всем объектам PL/SQL.


TRACE_PRF
 означает записывать в файл статистику быстродействия.


TRACE_SQL
 означает записывать в файл информацию отслеживания по всем SQL.


TRACE_TMS
 означает вводить штемпель времени для каждого элемента в файле отслеживания.

По умолчанию: 
TRACE_ALL


Правила:

Информация отслеживания может генерироваться только при выполнении файла .rdf. Вы не можете указывать запись в журнал, выполняя файл .rep.

AUTOCOMMIT

Указывает, должны ли автоматически фиксироваться изменения в базе данных (напр., CREATE). Учтите, что некоторые не-ORACLE базы данных (напр., SQL Server) требуют AUTOCOMMIT=YES.

Опции:	
YES



NO


По умолчанию: 
NO


NONBLOCKSQL

В Windows указывает, разрешать ли исполняться другим программам во время извлечения Oracle Reports данных из базы данных. Это ключевое слово игнорируется на платформах, иных чем Windows (напр., Motif).

Опции:	
YES



NO


По умолчанию: 
YES
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